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ビジュアルヘルプ – グラフ（３） 

 

軸の修正 

グラフの各軸の表示スタイルは、Graph→Modify Axis を選択するか、軸をダブルクリックすることで変更できま

す。 

これにより Modify Axis ダイアログが表示されます。 

ダイアログには軸の外観に関する様々な側面を扱うタブがあり、

さらにタブの外側にいくつかのコントロールが配置されていま

す。 

これらのグローバルコントロールには、標準的な Igor のダイア

ログコントロールが含まれます：Do It、To Cmd Line、To 

Clip、Help、Cancel ボタンに加え、ダイアログによって生成され

たコマンドを表示するボックスです。 

上部には、Axis ポップアップメニューと Live Update チェック

ボックスがあります。 

Axis ポップアップメニューには、前面のグラフで使用中のすべて

の軸が表示されます。 
 

変更したい軸を Axis メニューから選択するか、複数の軸に影響を与える場合は Multiple Selection を選択してく

ださい。 

Multiple Selection 項目の下には、特定の種類の軸を選択するためのショートカットを提供する項目があります。 

変更の種類に応じて適切なタブを選択します。 

ダイアログには以下のタブがあります： 

Axis タブ  Auto/Man Ticks タブ Ticks and Grids タブ 

Tick Options タブ Axis Label タブ  Label Options タブ 

Axis Range タブ 

 

Axis タブ 

選択した軸の軸モードを、線形、10 進対数、2 進対数、または日付/時刻に設定できます。 

日付/時刻モードは特殊です。 

軸を描画する時、Igor はコントロールウェーブの単位を確認し、日付/時刻軸とするべきかを判断します。 

したがって、日付/時刻軸を選択すると、ダイアログは直ちにコントロールウェーブの単位を変更します。 

Standoff チェックボックスは軸のオフセットをコントロールします。 

スタンドオフがオンの場合、Igor はトレースが軸を覆わないように軸をオフセットします： 
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プロット長方形の同じ辺に自由軸と標準軸が接続されている場合、標準軸のスタンドオフ設定は無視されます。 

これは重ね合わせプロットの作成を容易にするためです。 

Mirror Axis ポップアップメニューを使って、ミラー軸機能を有効

にします。 

ミラー軸とは、反対側の軸の鏡像となる軸です。 

左軸を右に、または下軸を上に対称移動できます。 

通常状態はオフであり、この場合、対称軸は存在しません。 

ポップアップメニューから On を選択すると、目盛付きのミラー

軸が表示されますが、目盛ラベルは表示されません。  

No Ticks を選択すると、目盛のないミラー軸が表示されます。 

Labels を選択すると、目盛と目盛ラベル付きのミラー軸が表示されます。 

ミラー軸は、自由軸を使う場合や Draw Between で軸を短縮する場合、期待通りの動作をしない可能性がありま

す。 

自由軸では目的が達成できない場合、埋め込みグラフの方が適切な解決策となる可能性があります。 

詳細は、ヘルプ Embedding and Subwindows を参照してください。 

自由軸はミラー軸も持つことができます。 

自由軸本体とは異なり、特定の自由軸に対するミラー軸は移動できません。 

常にプロット領域の反対側に固定されています。 

この機能は重ね合わせプロットの作成のために提供されています。 

詳細は「重ね合わせプロットの作成」のセクションを参照してください。 

Draw between 項目は、積み重ねグラフを作成するために使われ

ます。 

通常はこれらを 0% と 100% のままにします。 

これにより、Igor はプロット領域の全長または全幅に沿って軸を

描画します。 

50% と 100% を使うと、プロット領域の上半分のみに左軸を描

画できます（この例ではプロット領域を示すため鏡像軸が有効に

なっています）。  

 

Draw between を使った追加の例については、「積み重ねプロットの作成」および「分割軸の作成」のセクション

を参照してください。 

Offset 設定は、グラフの端と軸の間の距離をコントロールする方法を提供します。 

デフォルトの軸位置から実際の軸位置までの距離を指定します。 

この設定は、目盛ラベルにおけるゼロ文字のサイズ単位で指定されます。 

このため、グラフウィンドウのサイズを変更すると、軸オフセットは適切に調整されます。 

デフォルトの軸オフセットはゼロです。 

軸をグラフの端まで、または端を超えてドラッグすることで、軸オフセットをゼロに戻すことができます。 

グラフのマージン（全体的なグラフのプロパティを参照）を入力すると、その余白が軸オフセットを上書きします。 
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通常、グラフ上で軸をドラッグすることで軸オフセットを調整します。 

マウスが軸の上にある場合、カーソルが両方向の矢印に変わります。 

これは軸をドラッグできることを示しています。 

軸がミラー軸の場合、ドラッグすることはできず、カーソルも両方向の矢印に変化しません。 

Offset 設定は自由軸には影響しません。 

自由軸の位置を調整するには、Free Position セクションの設定を

使ってください。 

Thickness 設定では、軸および関連する目盛の太さをポイント単

位で設定します。 

太さは小数点以下の値も指定可能で、ゼロに設定すると軸と目盛

は表示されなくなります。  

自由な位置は軸をインタラクティブにドラッグすることで調整できます。 

絶対距離モードを使う時の位置調整には推奨される方法ですが、「交差位置」モードでは推奨されません。 

Axis タブの Font セクションでは、目盛ラベルと軸ラベルに使用するフォント、フォントサイズ、書体を指定しま

す。 

ある軸のみグラフの他の部分とは異なるフォントを使いたい場合を除き、この設定

は「デフォルト」のままにしておくべきです。 

Misc メニューの Default Font 項目を使って、すべてのグラフのデフォルトフォン

トを設定できます。 

Graph メニューの Modify Graph 項目を使って、特定のグラフのデフォルトフォ

ントを設定できます。 

軸ラベルのフォントは、軸ラベルテキスト内のエスケープコードでコントロールで

きます。 

詳細は「軸ラベル」のセクションを参照してください。  

軸のコンポーネントの色は、Color エリアの項目によってコントロールされます。 

 

Auto/Man Ticks タブ 

Auto/Man Ticks タブの項目は、軸に沿った目盛の位置をコント

ロールします。 

タブ上部のポップアップメニューから、目盛の位置をコントロー

ルする３つの方法のいずれかを選択できます。 

Auto Ticks を選択すると、Igor があなたのヒントを基に適切な

目盛間隔を計算します。 
 

Computed Manual Ticks を選択すると、目盛の配置位置と間隔を完全にコントロールできます。 

詳細は「計算された手動目盛」のセクションを参照してください。 

User Ticks from Waves を選択すると、目盛位置とラベル付けを完全にコントロールできます。 

ウェーブから取得した情報に基づいて目盛を配置し、ラベル付けします。 

詳細は「ウェーブからのユーザー目盛」のセクションを参照してください。 

Auto Ticks モードでは、選択した軸の推奨される主目盛数を Approximately パラメータボックスに入力すること

で指定できます。 

軸上の実際の目盛数は推奨値と異なる場合があります。 

これは、Igor が一般的な数値列（例：1, 2, 5）において適切な間隔で整数の目盛ラベルを表示するため、複数の要

素を考慮して調整を行うことによります。 
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ほとんどの場合、これにより自動的に正確で魅力的なグラフが生

成されます。 

選択した軸が対数軸の場合、Approximately パラメータは使用で

きません。 

選択した軸の副目盛は、Minor Ticks チェックボックスを使って

オン/オフを切り替えられます。 
 

Minimum Sep 設定は、副目盛が有効な場合の副目盛の表示をコントロールします。 

副目盛間の距離が、ポイント単位で測定した指定された最小目盛間隔未満となる場合、Igor はより密度の低い目盛

配置方式を選択します。 

対数軸では、Minor Ticks と Tick Separation が副目盛以下の目盛の描画に影響します。 

 

Ticks and Grids タブ 

Ticks and Grids タブでは、目盛、目盛ラベル、およびグリッド線

のコントロールが可能です。 

 

Exponential Labels（指数ラベル） 

目盛のラベルに使われる数値が非常に大きいか非常に小さくなった場合、Igor は指数表記に切り替わり、目盛のラ

ベルには小さな数値を表示し、軸ラベルには 10 の累乗を表示します。 

軸ラベルにおける 10 の累乗の使用については、「軸ラベル」のセクションで説明しています。 

対数軸の場合、目盛には累乗が含まれます。 

Low Trip と High Trip の設定により、目盛ラベルが通常の表記

から指数表記に切り替わるポイントをコントロールできます。 

軸の大きい方の端の絶対値が Low Trip と High Trip の間にある

場合、通常の表記が用いられます。 

それ以外の場合は指数表記が用いられます。 

ただし、指数がゼロとなる場合には常に通常の表記が用いられま

す。  

実際には、Low Trip と High Trip のパラメータには独立した２つのセットが存在します。 

通常軸用と対数軸用です。 

Low Trip ポイントは 1e-38 から 1 の範囲で設定可能であり、通常軸ではデフォルト値が 0.1、対数軸では 1e-4 

となります。 

High Trip ポイントは 1 から 1e38 の範囲で設定可能であり、デフォルト値は 1e4 です。 

状況によっては、Igor がこれらのトリップポイントの設定を尊重しない場合があります。 

通常の目盛ラベルを表示する余地がない場合、Igor は通常の表記を指定していても指数表記を使います。 

Engineering and Scientific ラジオボタンは、指数表記が使われる場合に目盛ラベルがエンジニアリング表記または

科学表記のどちらを使うかを指定できます。 

対数軸には影響しません。 

工学表記法とは、指数が常に３の倍数である指数表記法に過ぎません。 
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Exponent Prescale 設定を使うと、目盛と軸ラベルの縮尺を、Igor が選択する値とは異なる値に強制的に設定でき

ます。 

例えば、X 軸のスケーリング範囲が 9pA から 120pA のデータがあり、これを対数軸で表示する場合、Igor は目

盛を 10pA と 100pA で表示します。 

ただし、目盛のラベルに 10 と 100 を表示し、軸ラベルに pA を表示したい場合は、Exponent Prescale を 12 に

設定できます。 

詳細は「軸ラベル」のセクションを参照してください。 

 

Date/Time Tick Labels（日付/時刻目盛ラベル） 

Ticks and Grids タブの Date/Time Tick Labels エリアについては、「日付/時刻軸」のセクションで説明していま

す。 

 

Tick Dimensions（目盛の次元） 

Tick Dimensions エリアの項目を使って、各種類の目盛の長さや太さ、および軸線に対する目盛の位置をコントロ

ールできます。 

Igor は４種類の目盛を区別します：主目盛、副目盛、「5 番目の」目盛、およびサブ副目盛です。 

 

目盛の太さは通常、軸の太さに従います。 

個々の目盛の太さは、「Auto」という文字を小数点付きのポイント単位で指定した希望の太さに置き換えることで上

書きできます。 

ゼロ値は「Auto」と同等です。 

目盛の長さは通常、目盛のラベルに使われるフォントとフォント

サイズに基づいて計算されます。 

小数点で独自の値を直接入力することができます。 

例えば、主目盛には 6、副目盛には 3、5 番目または強調された副

目盛には 4.5 といった値を入力できます。 

サブ副目盛は対数軸にのみ適用されます。 

 

Location ポップアップメニューでは、選択した軸の目盛線を軸の外側、軸をまたぐ位置、軸の内側に配置するか、

または軸に目盛線を全く表示しないように指定できます。 

 

Gird（グリッド） 

グリッド線を表示したくない場合は、Grid ポップアップメニューから Off を選択してください。 

On を選択すると、主目盛と副目盛の両方にグリッド線が表示されます。「主要目盛のみ」を選択すると、主要目盛

にのみグリッド線が表示されます。 
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Igor は 1 から 5 までの番号で識別される 5 つのグリッドスタイルを提供します。 

異なるグリッドスタイルには、細い、太い、点線、または実線の主要グリッド線と補助グリッド線があります。 

スタイルがゼロ（デフォルト）に設定され、グラフ背景が白の場合、グリッドスタイル 2 が使われます。 

グラフ背景が白ではない場合、グリッドスタイル 5 が使われます。 

グリッド色のパレットを使って、グリッド線の色を設定します。 

デフォルトでは薄い青色です。 

ここにある例は、通常より太い軸線と最も太いグリッド線（Y 軸）を持つグラフを示しています： 

   

   

   

Draw from と to の設定を使うと、グリッド線の長さを制限できます。 

Axis タブで同様の設定を使って軸の１つを短縮して、グリッド線を一致させたい場合に便利です。 

 

Zero Line（ゼロライン） 

選択した軸のゼロラインは、Zero Line チェックボックスを使っ

てコントロールできます。 

ゼロラインとは、座標軸の値がゼロとなる点でグラフを横切る、

座標軸に垂直な直線です。 

対数軸では、Zero Line チェックボックスは使用できません。 

Zero Line をオンにすると、Style ポップアップメニューから線

種を選択できるようになります。 
 

線の太さは 0 から 5 までの小数点で設定できます。 

ゼロラインは軸と同じ色になります。 
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Tick Options タブ 

Tick Options タブでは、目盛と目盛ラベルの詳細なコントロール

が可能です。 

Enable/Inhibit セクションでは、目盛を特定の範囲に制限した

り、特定の目盛を非表示にしたりできます。 

Log Ticks セクションでは、対数軸上の細かな目盛とラベルをコ

ントロールできます。 
 

Tick Label Tweaks セクションでは、以下の設定が可能です： 

チェックボックス   結果 

Thousands separator  10000 のような数字ラベルを 10,000 として表示します。 

Zero is 0  通常 0.0 または 0.00 と表示される箇所で、ゼロの目盛を強制的に 0 として表

示するように設定します。 

No trailing zeroes  通常 1.50 や 2.00 と表示される目盛ラベルを、1.5 や 2.と表示します。 

No leading zero   0.5 のような目盛ラベルを .5 と表示します。 

Tick Unit Prefix is Exponent 目盛に接頭辞と単位（mTorr）がある場合、指数表記（10⁻⁶ Torr）に変換す

します。 

No Units in Tick Labels  目盛に単位が表示される場合、それを非表示にします。 

Units in Every Tick Label  各ラベルに通常軸、指数、または接頭辞と単位を記載します。 

 

Axis Labels タブ 

「軸ラベル」のセクションを参照してください。 

 

Label Options タブ 

Label Options タブでは、軸ラベルと目盛ラベルの位置と向きを

コントロールできます。 

これらのラベルを完全に非表示にすることも可能です。 

通常、軸ラベルの位置はグラフ上でドラッグするだけで調整でき

ます。  

Axis label position または Axis label margin と Axis label lateral offset の設定は、位置を数値で精密にコント

ロールしたい場合に役立ちます。 

軸ラベルの位置決めに使われる計算は、Label Position Mode メニューの設定に依存します。 

デフォルトでは Compatibility に設定されており、古いバージョンの Igor でも動作します。 

他のモードでは、複数の軸上でラベルをより正確に揃えることができます。 

配置モードの選択は、メニュー下部の３つの設定の意味に影響します。 
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Compatibility モードでは、Igor が軸ラベルを配置する方法は、指定されたプロット長方形の辺に自由軸が付けら

れているかどうかに依存します。 

自由軸が付けられていない場合、ラベル位置は対応するウィンドウの端から計算されます。 

これを軸ラベルマージンと呼びます。 

したがって、軸の位置を変更しても軸ラベルは移動しません。 

一方、自由軸がプロット長方形の辺に付けられている場合、ラベルの位置は軸から計算され、軸を移動させるとラベ

ルもそれに伴って移動します。 

軸ラベルの設定方法が状況によって異なるため、Axis label margin または Axis label position のいずれかの設定

が使用できない場合があります。 

自由軸と同じ辺上に軸を選択した場合、Axis label position 設定が使用可能になります。 

複数の軸を選択している場合、両方の設定が使用可能になることがあります。 

軸ラベルの位置は、軸からラベルまでの距離で、ポイント単位で計算されます。 

軸ラベルのマージンは、グラフの端からラベルまでの距離で、ポイント単位で計算されます。 

デフォルトのラベルマージンはゼロで、これにより軸ラベルはグラフの端に密着します。 

マージンモードはグラフの端を基準に計算するのに対し、軸モードは軸の

位置を基準に計算します。 

軸モードを使うと、軸を移動した時にラベルが自由軸に沿って移動しま

す。 

マージンモードは、積み重ねグラフ上でラベルを揃える時に便利です。 

Axis label margin 設定はマージンモードに適用され、Axis label 

position 設定は軸モードに適用されます。  

絶対モードは距離をポイント単位で計算します。 

スケーリングモードは同様の数値を持ちますが、フォントサイズの変化に応じてスケーリングされます。 

Labels ポップアップメニューは、どのラベルが表示されるかをコントロールします。 

On は通常の軸ラベルを表示します。 

Axis Only は軸ラベルを残し、目盛ラベルを削除します。 

Off は軸ラベルと目盛ラベルの両方を削除します。  

軸と目盛ラベルの回転角度は、-360 度から 360 度の間の任意の値に設定できます。 

 

Label Options タブ 

「グラフのスケーリング」のセクションを参照してください。 

 

手動の目盛 

Igor による目盛の自動選択が目的に合わない場合、または目盛を希望通り

に調整する方法が見つからない場合、Igor では目盛を自分で指定する２つ

の方法を提供しています。 

Modify Axis ダイアログの Auto/Man Ticks タブでは、Computed 

Manual Ticks または User Ticks from Waves のいずれかを選択できま

す。 
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Computed Manual Ticks（計算された手動目盛） 

Computed Manual Ticks を使うと、目盛間の増分と目盛位置の計算開始点を数値で指定できます。 

この手動目盛のスタイルは、通常の軸および日付/時刻軸で使用できます。 

通常の対数軸では使用できませんが、対数線形モードでは使用できます。 

Computed Manual Ticks を選択すると、Auto/Man Ticks タブ

の対応する設定が使用可能になります。 

Set to auto values ボタンをクリックすると、Igor は Compute 

Manual Ticks セクション内の全項目を、Igor が自動的に目盛を

決定した場合に設定される値に設定します。 

これが通常は良い出発点となります。 

Canonic tick 設定を使うと、軸上の主目盛の値を指定できます。 
 

Tick increment 設定を使うと、主目盛ごとの軸の単位を指定します。 

これらの数値はいずれも、仮数部と指数部として指定されます。 

標準的な目盛は、必ずしも軸上の最初の主目盛とは限りません。 

対数線形モードで大きな範囲の対数軸に計算された手動目盛を使う場合、ダイアログの設定は目盛の指数を参照しま

す。 

ある物体が冷えていく過程で、その温度を表示したいと想像してみてください。 

秒単位で時間を表示したいが、分単位の整数が軸上のどこに位置するかが明確であるようにしたいとします。 

下軸に対して手動目盛を有効にし、標準目盛をゼロに設定し、目盛増分を 60 に設定します。 

３つの副目盛を１つの主目盛に指定し（Minor Ticks セクションの Number per major tick）、毎秒の副目盛を強

調表示（Emphasize every 設定）することで、30 秒と 15 秒のポイントを表示できます。 

これは次のグラフを生成します： 

 

ここで、t=60 秒の時点を拡大表示したいと想像してみてください。 

 

基準目盛（t=0）はグラフ上に表示されませんが、主目盛の位置をコントロールしています。 
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User Ticks from Waves（計算された手動目盛） 

Computed Manual Ticks を使うと、等間隔の目盛を望む限り、目盛を完全にコントロールできます。 

通常の対数軸で独自の目盛を指定したい場合、または等間隔でない目盛が必要な場合は、User Ticks from Waves 

が必要です。 

User Ticks from Waves を設定する最初のステップは、２つのウェーブを作成することです：1 次元数値ウェーブ

とテキストウェーブです。 

数値ウェーブに入力された数値は、軸単位での目盛位置を指定します。 

対応するテキストウェーブの行は、目盛のラベルを指定します。 

Tm/T（融解温度／温度）を関数としてデータをプロットしたい

が、目盛ラベルは適切な温度値に設定したいします。 

右のデータから始めます： 

 

これは右のグラフを表示します： 

 

軸のラベル付け用のウェーブを作成します： 

Make/N=5 TickPositions 

Make/N=5/T TickLabels 

Tm が 450 度であり、20 度、30 度、50 度、100 度、400 度の目

盛りが適切であると判断した場合、これらの数値をテキストウェ

ーブの TickLabels に入力します。 

この時点で、TickPositions ウェーブに目盛位置を入力する便利な

方法は、適切と思われる関係を具体化したウェーブの代入です： 

TickPositions = 450/str2num(TickLabels) 

 

str2num 関数がラベルウェーブ内のテキストを数値データとして

解釈するために使われたことに注意してください。 

もちろん、これはテキストが数字のみを含む場合にのみ機能しま

す。 

 



13 

 

最後に、下部の軸をダブルクリックして Modify Axis ダイアログ

を表示し、Auto/Man Ticks タブを選択し、User Ticks from 

Waves を選択します。 

TickPositions と TickLabels のウェーブを選択します。 

 

結果は右のグラフになります。 

 

ラベルには、特殊記号を含む他

のテキストを追加できます。 

例えば： 

 

最後に、テキストウェーブに列を追加し、もう一方の列に適切なキーワードを入力することで、副目盛、サブ副目

盛、強調された目盛を追加できます。 

ウェーブに列を追加するには、Data メニューから Redimension 

Waves を選択し、リストから対象のテキストウェーブ

（TickLabels）を選択して矢印をクリックします。 

次に、列数を 0 から 2 に変更します。 

 

この追加した列には必ず Tick Type という列ラベルを付ける必要

があります。 

SetDimLabel 1, 1, 'Tick Type', TickLabels 

次元ラベルを使うと、ウェーブの数字ではなく名前を用いて行や

列を参照できます。 

したがって、Tick Type 列は必ずしも 2 番目の列（つまり列 1）

である必要はありません。 

テーブルに次元ラベルを表示する方法については、ヘルプ 

Showing Dimension Labels を参照してください。 
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例えば、右のように入力します。 

 

このデータを使って、User Ticks 

from Wave を適用します。 

右のように、軸の間に目盛が作成され

ます（Expand したところ）。 

  

目盛ウェーブを作成する簡単な方法は、Modify Axis ダイアログにウェーブを生成させることです。 

ユーザー目盛を設定したい軸をダブルクリックします。 

Auto/Man Ticks タブをクリックし、ポップアップメニューから 

User Ticks from Waves を選択します。 

New from Auto Ticks ボタンをクリックしてください。 

Igor は <graphname>_<axisname>_labels および 

<graphname>_<axisname>_values という形の名前を持つウ

ェーブを生成し、それらを Labels と Locations のポップアップ

メニューで選択します。 

 

Do It をクリックします。 

生成されたウェーブを編集すると、グラフ上の目盛が変化します。 

TickWavesFromAxis コマンドを使って、プログラムで同じことを実現できます。 

 

対数軸 

対数軸を作成するには、Modify Axis ダイアログの Axis タブで軸モードを Log に設定します。 

通常の対数軸では、計算された目盛とゼロラインはサポートされていません。 

Igor には対数軸の目盛付け方法が３種類あり、軸の範囲（桁数）に応じて使われます：通常、小範囲、大範囲で

す。 

通常モードは、ディケード数が約 1/3 から約 10 の範囲にある場合に使われます。 

正確な上限は、軸の物理的なサイズとフォントサイズによって異なります。 

範囲のディケード数が 2 未満または 5 を超える場合、LogLin チェックボックスを選択することで、Igor に

small/large range メソッドの使用を強制できます。 

この操作を行うと、線形軸の全設定（手動目盛を含む）が有効になります。 

以下は 0.5 から 30 の範囲を持つ通常の対数軸です： 
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1.5 から 4.5 の範囲にズームインすると、次のようになります： 

 

しかし、LogLin チェックボックスをオンにすると、より良い結果が得られます： 

 

 

対数軸を選択すると、Tick Options タブの Log Ticks ボックスが使用可能になります（LogLin はオフ）。 

Max log cycles with minor ticks 設定は、ログ軸に副目盛を表示

するかどうかをコントロールします。 

この設定は 0 から 20 の範囲で指定でき、デフォルトは 0 です。 

0 または auto に設定した場合、Igor が自動的に副目盛の適否を

判断します。 

それ以外の場合、軸のディケード数がこの数値を超えると、副目

盛は表示されません。 

副目盛も、表示スペースが不足している場合は表示されません。  

同様に、Max log cycles with minor tick labels 項目を使うことで、対数軸の副目盛にラベルを表示するタイミング

をコントロールできます。 

これは 0 から 8 までの数値です。 

0 に設定すると副目盛ラベルが無効になります。 

軸の桁数がこの設定値より少ない限り、副目盛にはラベルが表示されます。 

 

日付/時刻軸 

数値軸に加え、Igor では日付、時刻、または日付/時刻でラベル付けされた軸をサポートしています。 

日付および日付/時刻は、Igor では 1904 年 1 月 1 日午前 0 時からの経過秒数として表現されます。 

Igor では、日付を単精度浮動小数点数で正確に表現することはできません。 

日付/時刻を保存するには、必ず倍精度ウェーブを使ってください。 

（単精度ウェーブは X スケーリングから計算された日付と日付/時刻を提供できますが、データ値からは提供できま

せん。） 

日付の表現方法に関する詳細な説明については、ヘルプ Date/Time Waves を参照してください。 

日付のない時間は、２つの方法で考えることができます：時刻として、そして、経過時間として。 
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時刻は Igor において、深夜 0 時からの経過秒数として表現されます。 

経過時間は、-9999:59:59 から +9999:59:59 の範囲の秒数で表されます。 

整数秒単位では、この経過時間の範囲は符号付き 32 ビット整数ウェーブで正確に表現できます。 

単精度浮動小数点ウェーブは、約±4600 時間までの整数秒単位の経過時間を正確に表現できます。 

Igor は、軸をコントロールするウェーブの適切な単位が「dat」

である場合、その軸上に日付または時刻を表示します。 

これは大文字小文字を区別します—「Dat」は機能しません。 

ウェーブの単位は、Data メニューの Change Wave Scaling 項

目、または SetScale コマンドで設定できます。 

ウェーブのグラフの水平軸を日付または時刻軸にするには、その

軸をコントロールするウェーブの X 単位を「dat」に設定する必要

があります。 

XY グラフでは、曲線の X 座標を提供するウェーブのデータ単位を

「dat」に設定する必要があります。  

どのグラフタイプにおいても、縦軸を日付または時間軸にするには、その軸をコントロールするウェーブのデータ単

位を「dat」に設定する必要があります。 

Modify Axis ダイアログの Axis タブで軸モードとして Date/Time を選択すると、ダイアログは適切なウェーブ単

位を「dat」に設定します。 

Igor で軸を日付または時刻として表示するには、以下の追加条件を満たす必要があります：軸は少なくとも 2 秒間

をカバーし、両端が日付/時刻値の有効範囲内にあること。 

これらの条件のいずれかが満たされない場合、Igor は１つの目盛を表示します。 

軸が日付/時刻モードの場合、Modify Axis ダイアログの Ticks 

and Grids タブにある Date/Time Tick Labels ボックスが使用

可能になります。 

Time Format のポップアップメニューから、Normal、Military、

Elapsed（経過時間）のいずれかを選択できます。 

時刻表示には Normal また は Military を、経過時間表示には 

Elapsed を使ってください。  

Normal モードでは、深夜 12 時の 1 分前は「午後 11 時 59 分 00 秒」と表示され、深夜 12 時は「午前 0 時 00 分

00 秒」と表示されます。 

Military モードでは、23:59:00 と 00:00:00 のように表示されます。 

Elapsed モードでは、-9999:59:59 から +9999:59:59 までの時間を表示できます。 

このモードは、軸上に表示される値が実際に経過時間（例：23:59:00）である場合に意味を持ちます。 

値が実際には日付/時刻（例：7/28/93 23:59:00）の場合、意味をなさないため目盛ラベルは表示されません。 

 

カスタムの日付フォーマット 

短い形式、長い形式、および省略形式では、日付はシステムの日付/時刻設定に従

って表示されます。 

Date Format のポップアップメニューから Other を選択すると、目盛の書式を

ほぼ完全にコントロールできるダイアログが表示されます。 

このダイアログでは、さまざまな組み込みフォーマットから選択するか、完全にカ

スタムのフォーマットを作成することができます。 
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軸の範囲に応じて、目盛ラベルには日付または日付と時刻が表示さ

れる場合があります。 

日付と時刻の両方が表示されている場合、Suppress Date チェック

ボックスを選択することで日付の表示を抑制できます。 

経過時間モードを選択した場合、日付が表示されないため、このチ

ェックボックスは関係ありません。 

 

 

日付/時刻の例 

以下の例は、Y 値が温度で、SetScale コマンドによって設定された X 値が日付であるウェーブの日付/時刻グラフを

作成する方法を示しています： 

// 年間の気温を含むウェーブを作成 

Make /N=365 temperature   // 単精度データ値 

// スケーリングを設定し、X 値を日付にする 

Variable t0, t1 

t0 = Date2Secs(2000,1,1); t1 = Date2Secs(2001,1,1) 

SetScale x t0, t1, "dat", temperature   // 倍精度 X スケーリング 

// ウェーブの Y 値に温度データを入力 

t0 = Date2Secs(2000,1,1); t1 = Date2Secs(2000,3,31)   // winter 

temperature(t0, t1) = 32     // it's cold 

t0 = Date2Secs(2000,4,1); t1 = Date2Secs(2000,6,30)   // spring 

temperature(t0, t1) = 65     // it's nice 

t0 = Date2Secs(2000,7,1); t1 = Date2Secs(2000,9,31)  // summer 

temperature(t0, t1) = 85     // it's hot 

t0 = Date2Secs(2000,10,1); t1 = Date2Secs(2000,12,31)  // fall 

temperature(t0, t1) = 45     // cold again 

// データを平滑化 

CurveFit sin temperature 

temperature= K0+K1*sin(K2*x+K3) 

// ウェーブをグラフ表示 

Display temperature 

SetAxis left, 0, 100;Label left "temp" 

Label bottom "2000" 

 



18 

 

SetScale コマンドは、温度ウェーブの X 値が 2000 年をカバーするように設定します。 

この例では、日付/時刻の情報はウェーブの X 座標値に含まれています。 

X 値は常に倍精度です。 

ウェーブ自体は、Y 値には日付/時刻の情報ではなく温度情報を格納しているため、倍精度として宣言されていませ

ん。 

 

日付/時刻軸の目盛 

通常の軸と同様に、日付/時刻軸における Igor の自動の目盛選択が、望まない結果となる場合があります。 

こうしたケースでは、日付/時刻軸に計算された手動目盛を使用できます。 

計算された手動目盛を使うには、軸をダブルクリックするか、

Graph→Modify Axis を選択して Modify Axis ダイアログを表示し

ます。 

Auto/Man Ticks タブを選択し、そのタブのメニューから 

Computed Manual Ticks を選択します。 

最初のステップは Set to Auto Values ボタンをクリックすること

です。  

Canonic Tick 設定の下にあるポップアップメニューから Date、Time、Date&Time のいずれかを選択してくださ

い。 

目盛増分設定の単位を選択し、増分値を入力してください。 

 

フェイク軸 

単純な方法でデータに関連付けられない軸を作成する必要が生じる場合があります。 

一つの方法は、ウェーブに関連付けられていない自由軸を使います（NewFreeAxis コマンドのヘルプを参照）。 

Transform Axis パッケージはこの方法を使って、データの異なるビューを反映するミラー軸を作成します。 

例として、主軸が波長を示すのに対し、ミラー軸が波数を示す場合が挙げられます。 

例として、File→Example Experiments→Graphing Techniques→Transform Axis Demo を選択してください。 

別の方法として、Igor の描画ツールを使ってフェイク軸を作る方法があります。 

例として、File→Example Experiments→Graphing Techniques→New Polar Graph Demo または File→

Example Experiments→Graphing Techniques→Ternary Diagram Demo を選択してください。 

 

軸ラベル 

グラフの軸ラベルのテキストは、次のいずれかから取得されます。 

軸をコントロールするウェーブに単位を指定した場合、Change 

Wave Scaling ダイアログを使うと、Igor はこれらの単位を使って

軸にラベルを付けます。 

このラベル付けは、Modify Axis ダイアログの Axis Label タブで

明示的に入力することで上書きできます。 

ダイアログを表示するには、Graph→Label Axis を選択するか、軸

ラベルをダブルクリックします。 
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Axis ポップアップメニューからラベルを付ける軸を選択し、Axis 

Label エリアに軸ラベルのテキストを入力します。 

ラベルの書式設定オプションは、Label Options タブでさらに利用

できます。 

 

軸ラベルは２つの部分から構成されます：ラベルのテキストと、フォント、フォントサイズ、上付き文字や下付き文

字などの特殊効果です。 

Axis Label エリアにテキストを入力して指定します。 

テキスト入力中、いつでも Insert エリアのポップアップメニューから特殊効果を選択できます。 

Label Preview エリアでは、軸ラベルがどのように表示されるかを、テキストと特殊効果を考慮して確認できます。 

プレビューにはテキストを入力できません。 

また、Live Update チェックボックスをオンにすると、グラフ上にラベルを表示できます。 

 

軸ラベルのエスケープコード 

特殊効果を選択すると、Igor はテキストにエスケープコードを挿入します。 

エスケープコードはバックスラッシュ文字と、それに続く１つ以上の文字で構成されます。 

これは指定した特殊効果を表します。 

エスケープコードは複雑ですが、その効果はラベルプレビューボックスで確認できます。 

 

テキスト内の任意の箇所で特殊効果を挿入できます。 

その箇所でクリックし、Insert ポップアップメニューから特殊効果を選択してください。 

Font ポップアップメニューから項目を選択すると、ラベル内の後続の文字のフォントを変更するコードが挿入され

ます。 

Font ポップアップには Recall font 項目もあります。 

この項目は、精巧な軸ラベルを作成するために使われます。 

ヘルプ Elaborate Annotations を参照してください。 

Font Size ポップアップメニューから項目を選択すると、ラベル内の後続の文字のフォントサイズを変更するコード

が挿入されます。 

フォントサイズのポップアップには、複雑な軸ラベルを作るための Recall size 項目も含まれています。 

 

 

 

 



20 

 

軸ラベルの特殊効果 

Special ポップアップメニューには、上付き文字、下付き文字、文字揃え、文字色な

どの多くの機能をコントロールする項目に加え、特殊文字、マーカー、画像の挿入な

どの項目が含まれています。 

Store Info、Recall Info、Recall X Position、Recall Y Position の各項目は、詳細

な注釈を作るために使われます。 

「詳細な注釈」のセクションを参照してください。 

最も一般的に使われる項目は、Superscript（上付き文字）、Subscript（下付き文

字）、Normal です。 

上付き文字または下付き文字を作成するには、Special ポップアップメニューから目

的のコードを挿入し、上付き文字または下付き文字のテキストを入力した後、

Normal コードで終了します。 

例えば、「Phase space density (s3m-6)」と表示される軸ラベルを作成したいとし

ます。 

これを行うには、「Phase space density (s)」と入力し、Special ポップアップメ

ニューから Superscript を選択し、「3」と入力し、Normal を選択し、「m」と入

力し、Superscript を選択し、「-6」と入力し、Normal を選択し、最後に「)」と

入力します。 

これらの項目に関する完全な説明については、ヘルプ Annotations を参照してくだ

さい。 

Wave controlling axis 項目は、指定された軸にプロットされた最初のウェーブの名

前を表示するコードを挿入します。 

Trace Symbol サブメニューは、選択したトレースのプロットに使われるシンボルを

描画するコードを挿入します。 

Marker サブメニューは、マーカー記号を描画するコードを挿入します。 

これらの記号は、グラフ内のどのトレースとも独立しています。 

Special メニューの下の Character メニューには、軸ラベルに追加する特殊文字を

選択できるパレットが表示されます。 

 

軸ラベルの単位 

Units ポップアップメニューの項目は、軸の範囲が変更されると自動的に更新される

軸ラベルを作成するためのエスケープコードを挿入します。 

たとえば、軸のコントロールウェーブに単位を指定した場合、Units ポップアップメ

ニューから Units 項目を選択することで、その単位を軸ラベルに表示できます。 

適用できる場合、Igor はラベルに接頭辞（µ はマイクロ、m はミリなど）を自動的

に付加し、軸の範囲が変化した場合には接頭辞を適切に変更します。 

軸の範囲は、軸を明示的に設定した場合や自動スケーリングされた場合に変化しま

す。 

Units ポップアップメニューから Scaling または Inverse Scaling 項目を選択する

と、Igor は適切な場合に軸ラベルに 10 の累乗（x10³、x10⁶ など）のスケーリング

を自動的に追加し、軸の範囲が変更された場合にこのスケーリングを変更します。 

Trial Exponent ボタンは、ラベルのプレビューでのみ使われる指数を決定します。 

これにより、軸スケーリングの条件が異なる場合にラベルがどのように表示されるか

を確認できます。 
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これらの方法はいずれも曖昧になり得ます。 

軸がスケール係数で乗算されたのか、それとも単位自体にスケール

係数が含まれているのか、明確ではないためです。 

より明確な方法は、Exponential Prefix（指数接頭辞）エスケープ

コードを使うことです。 

これは Scaling コードと同一ですが、「x」がありません。 

単位の乗数であることが明らかな文脈で使用できます。 

例えば、軸の範囲が 0 から 3E9（単位：cm/s）の場合、「Speed, 

\ucm/s」と入力すると「Speed, 109cm/s」が生成されます。 

 

軸ラベルでは、スケーリング情報を括弧で囲むのが一般的です。 

例えば、ラベルに「Joules (x10⁶)」と記載されている場合があります。 

スケーリングまたは逆スケーリングのエスケープコードを括弧で囲むだけで実現できます。 

軸のスケーリングが x100 である場合、Igor はこれを省略し、括弧も省略するため、「Joules (x100)」や

「Joules ()」ではなく「Joules」と表示されます。 

スケーリングを指定しない場合でも、軸の範囲がスケーリングを必要とする場合、Igor は軸上の目盛りの１つにラ

ベルを付け、軸のスケーリングを示します。 

これはグラフが誤解を招くのを防ぐための緊急措置です。 

この現象を防ぐには、ラベルに手動オーバーライドのエスケープコード \u#2 を挿入してください。 

エスケープコードの位置や目盛には、スケーリングや単位の情報は追加されません。 

対数軸の場合の状況は少し異なります。 

対数軸はその性質上、スケーリングする必要がなく、軸ラベルには単位やスケーリングのエスケープコードが使われ

ません。 

対数軸のコントロールウェーブに単位が設定されている場合、Igor は自動的に各主目盛のラベルに適切な接頭辞と共

に単位を付与します。 

 

グラフ内の注釈 

注釈にはテキストボックス、凡例、タグが含まれます。 

タグは特定のデータポイントに紐づけられたテキストボックスの一種です。 

グラフにテキスト注釈を追加するには、Graph→Add Annotation を選択し

ます。 

これにより、Add Annotation ダイアログが表示されます。 

グラフ上にテキスト注釈が既に存在する場合、それをダブルクリックするこ

とで編集できます。 

これにより Modify Annotation ダイアログが表示されます。 

詳細はヘルプ Annotations を参照してください。  

 

情報パネルとカーソル 

グラフの情報を表示するには、Graph→Show Info を選択します。 

情報パネルは、グラフ内のウェーブの値を正確に表示します。 

グラフをターゲットウィンドウにしている状態で情報パネルを非表示にするには、Graph→Hide Info を選択しま

す。 
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最大５組の異なるカーソルペア（AB から IJ まで）を使用できま

す。 

使用可能なペアをコントロールするには、歯車アイコンをクリッ

クし、Show Cursor Pairs サブメニューからカーソルペアを選択

します。 

カーソルは、ウェーブ上で特に注目すべきポイントの範囲を指定

する便利な方法を提供します。 
 

例えば、ウェーブの特定の範囲のポイントに対してカーブフィッ

ティングを行いたい場合、範囲の一端にカーソル A を、もう一端

にカーソル B を配置することから始めます。 

次に、Analysis メニューから Curve Fitting ダイアログを呼び出

せます。 

このダイアログの Data Options タブには範囲コントロールがあ

ります。 

Cursors ボタンをクリックすると、フィッティングの範囲がカー

ソル A からカーソル B までの範囲に設定されます。  

 

カーソルの使用 

情報パネルを初めて表示したとき、カーソルはホーム位置にあり、どのウェーブにも関連付けられていません。 

スライドコントロールは無効化され、表示エリアには値が表示されません。 

カーソルを有効にするには、カーソルをクリックし、値を確認したいウェーブの目的の地点までドラッグします。 

カーソルがグラフ上に表示され、カーソルのホームアイコンが黒く変化しま

す。これはカーソルがアクティブであることを示しています。  

カーソルが置かれているウェーブ名が、カーソル名の横に表示されます。 

カーソルは、トレースや画像プロット上の任意の地点にドラッグできます。 

カーソルを１要素分移動させるには、キーボードの矢印キーを使います。 

カーソルがトレース上にある場合、左右の矢印キーを使用できます。 

画像上にある場合は、左右上下の矢印キーを使用できます。 

Shift キーと矢印キーを同時に押すと、カーソルが 10 倍の距離移動します。 

カーソルがトレース上にある場合、スライドコントロールを左右にドラッグできます。 

画像上にある場合は、どの方向にもドラッグできます。 

ペアのカーソルが両方ともグラフ上にあり、かつ両方ともアクティブな場合、スライドコントロールは両方のカーソ

ルを同時に移動させます。 

カーソルを１つだけ移動させたい場合は、マウスを使ってそのカーソルを新しい位置にドラッグできます。 

移動させたくないカーソルを無効化することで、一方のカーソルだけを移動させる別の方法があります。 

これを行うには、カーソルのホームアイコンをクリックします。 

これによりホームアイコンが黒から白に変化し、カーソルが非アクティブであることを示します。 

その後、スライドコントロールはアクティブなカーソルのみを移動させます。 

ペアの両方のカーソルを同時にドラッグして移動することもできます。 

両方のカーソルをグラフ上に置いた状態で、Shift キーを押しながらカーソルのいずれかをクリックしてドラッグし

ます。 

マウスでカーソルを新しい位置にドラッグすると、Igor はまずカーソルが現在紐付けられているトレースを検索し

ます。 

新しい位置が現在のトレース上のポイントに近接していない場合にのみ、他のすべてのトレースが検索されます。 
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現在のトレースに対するこの優先的な扱いを利用することで、目的の領域で複数のトレースが重なっている場合で

も、カーソルが確実に目的のトレース上に配置されるようにできます。 

カーソルのホームアイコンを右クリックし、ポップアップメニューからトレース名

を選択することで、特定のトレースにカーソルを紐付けることができます。 

グラフからカーソルを削除するには、カーソルをプロット領域の外にドラッグする

か、カーソルホームアイコンを右クリックして Remove Cursor を選択します。 
 

 

フリーカーソル 

デフォルトでは、カーソルはトレース上の特定のポイント、または画像プロットの特定の要素に付随します。 

対照的に、フリーカーソルはグラフのプロット領域内のどこにでも移動できます。 

カーソルをフリーにするには、情報パネルのカーソルのホームアイコン

を右クリックし、表示されるポップアップメニューから Style→Free を

選択します。 
 

 

カーソルのスタイル 

デフォルトでは、カーソル A と B はグラフ上に表示され、A には円形の

アイコン、B には四角形のアイコンが使われます。 

その他のすべてのカーソルについては、デフォルトのスタイルは十字で

す。 

情報パネル内のカーソルホームアイコンを右クリックし、表示されるポ

ップアップメニューを使うことで、任意のカーソルのスタイルを変更で

きます。 

カーソルスタイル関数を作成し、後で呼び出して特定のカーソルスタイ

ル設定を適用することができます。  

情報パネルのカーソルのホームアイコンを右クリックし、表示されるポップアップメニューから Style→Style 

Function→Save Style Function を選択します。 

Igor は組み込みの Procedure ウィンドウ内でカーソルスタイル関数を作成します。 

この関数は編集可能で、Igor が使うデフォルト名よりも意味のある名前を付けることができます。 

スタイル関数をカーソルに適用するには、情報パネルのカーソルのホームアイコンを右クリックし、Style→Style 

Function→<あなたのスタイル関数>を選択します。 

 

カーソルを使ったプログラミング 

これらの関数とコマンドは、カーソルを使ったプログラミングに役立ちます。 

ShowInfo および HideInfo コマンドは、情報パネルを表示および非表示にします。 

Cursor コマンドはカーソルの位置を設定します。 

また、色、ヘアスタイル、グラフ情報パネル表示で使われる桁数など、カーソルの特性を変更するためにも使用でき

ます。 

CsrInfo 関数はカーソルに関する情報を返します。 
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次の関数はカーソルの現在の位置を返します： 

pcsr    qcsr    hcsr    vcsr    xcsr    zcsr 

次の関数は、カーソルが設定されているウェーブ（存在する場合）に関する情報を返します： 

CsrWave    CsrWaveRef    CsrXWave    CsrXWaveRef 

CursorStyle キーワードは、カーソルポップアップメニューの Style Function サブメニューに含めるユーザー定義

関数を指定します。 

ヘルプ Cursors - Moving Cursor Calls Function では、カーソルが移動した時にユーザー定義関数をトリガーする

方法について説明しています。 

 

トレースの識別 

マウスをトレースの上に置くと、Igor はそのトレースを識別するツールチップ

を表示できます。 

このモードを有効にするには、Graph→Show Trace Info Tags を選択してく

ださい。 

 

サブレンジの表示 

グラフにウェーブ全体を表示するだけでなく、表示するウェーブのサブレンジ（一部）を指定することもできます。 

この機能は主に、行列の列をあたかも個別の 1 次元ウェーブとして抽出したかのように表示することを目的としてい

ますが、他の部分集合の表示や n 個おきのデータポイントのスキップにも使用できます。 

ウェーブのサブレンジ（一部）を New Graph ダイアログおよび Append Traces ダイアログで表示するには、

More Choices ボタンをクリックして表示される、より複雑なバージョンのダイアログを使う必要があります。 

Y ウェーブを選択し、必要に応じて X ウェーブも選択して、Add ボタンをクリックしてください。 

これにより、トレースが下のリストに追加されます。 

その後、リスト内のサブレンジ（一部）パラメーターを編集できます。 

 

サブレンジ表示の構文 

Display、AppendToGraph、および ReplaceWave コマンドは、ウェーブリスト項目に対して次のサブレンジ構文

をサポートします： 

wave [rdspec][rdspec][rdspec][rdspec] 

rdspec は、次元インデックス（1 次元ウェーブの場合のポイント番号）で表現される範囲または次元の指定です。 

n 次元のウェーブの場合、n 個の指定を入力し、残りは省略します。 

範囲指定として指定できる rdspec は 1 つだけです。 

他の rdspec は、１つの数値要素インデックスまたは次元ラベル値でなければなりません。 
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次元の全範囲を示すために [] または [*]、連続したサブレンジを示すために [start,stop]、または次元インデック

ス inc を使って [start,stop;inc] を入力できます。 

* を入力して停止することは、その次元の最後の要素のインデックスを入力することと同じです。 

例えば： 

Make/N=100 w1D = p 

Display w1D[0,*;10]    // 10 ポイントごとに表示 

ModifyGraph mode=3, marker=19 

Make/N=(10,8) w2D = p + 10*q 

Display w2D[0][0,*;2]   // 行 0 の他のすべての列を表示 

ModifyGraph mode=3, marker=19 

 

サブレンジの構文規則は次のように言い換えることができます： 

１．1 次元の指定子のみ、表示される範囲を含めることができます。 

  範囲の正しい構文は： 

  [] または [*]  次元全体 

  [start, stop]  サブレンジ 

   stop は * にできる 

   stop は >=start でなければならない 

   範囲は包括的である 

  [start, stop; inc] 指定された正のインクリメントを使ったサブレンジ 

２．他の次元には、% 構文を使った１つの数値インデックスまたは次元ラベルを含める必要があります。 

  範囲指定ではない指定子の正しい構文は： 

  [index]  数値インデックスで指定された要素 

  [%label]  次元ラベルで指定された要素 

３．指定されていない高い次元は、[0] が指定されたものとして扱われます。 

XY 以外のプロットでは、X 軸ラベルはアクティブな次元（範囲が設定されているもの）の次元ラベル（存在する場

合）を使います。 

カーソルまたはタグがサブレンジトレースに配置された場合、使われるポイント番号は、あたかもそのサブレンジが

１次元ウェーブとして抽出されたかのような仮想的なポイント番号となります。 

エラーバー付きウェーブや、f(Z) として色、マーカーのサイズ、マーカーの番号を指定する場合にも、サブレンジ

構文がサポートされています。 
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サブレンジ表示の制限 

カテゴリプロットでは、カテゴリウェーブ（テキストウェーブ）はサブレンジを指定できません。 

ModifyGraph テキストマーカーモードでテキストを指定するために使われるウェーブはサブレンジを指定できませ

ん。 

サブレンジのトレースは、描画ツール（例：グラフ上のツールパレットにある「ポリゴン」アイコンをオプションキ

ーを押しながらクリック）では編集できません。 

ウォーターフォールプロットではサブレンジを使用できない場合があります。 

同じウェーブの複数のサブレンジをグラフで使う場合、それらはサブレンジ構文ではなくインスタンス表記のみを用

いて区別されます。 

例えば、 

w[][0],w[][1], 

を表示する時、 

ModifyGraph mode(w[][0])=1,mode(w[][1])=2 

ではなく、 

ModifyGraph mode(w#0)=1,mode(w#1)=2 

を使う必要があります。 

トレース情報には、指定されたトレースの描画に使われたトレースインスタンスとサブレンジが含まれます。 

「トレースの識別」のセクションを参照してください。 

 

グラフの印刷 

グラフを印刷する前に、Page Setup ダイアログを使ってページサイズと向きを設定する必要があります。 

File メニューから Page Setup を選択してください。 

グラフは縦よりも横が広い場合が多く、横向きで印刷した方が見栄えが良くな

ります。 

Page Setup ダイアログを呼び出す時には、印刷したいグラフが最前面のウィ

ンドウであることを必ず確認してください。 

Igor は、各エクスペリメントにおいて、すべてのグラフ用に１つのページ設定

を保存し、他の種類のウィンドウ用には他のページ設定を保存します。 

新しいエクスペリメントのデフォルトのグラフのページ設定は、Capture 

Graph Preferences ダイアログで設定できます。 

グラフを印刷するには、グラフがアクティブなウィンドウの状態で File→Print 

Graph を選択してください。 

File→Print Graph Preview を選択するとプレビューを表示できます。 

グラフはデフォルトで、グラフウィンドウと同じサイズで印刷されます。 

ただし、画面に収まらない場合は、同じアスペクト比で縮小されます。  

Igor Pro 7 以前では、印刷ダイアログは Fill Page や Same Aspect などのスケーリングモードをサポートしてい

ました。 

これらは Print ダイアログでは使用できなくなりました。 
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印刷前に PrintSettings を graphMode および graphSize キーワードと共に使うことで、同様の効果を得ること

ができます。 

 

ポスターサイズのグラフの印刷 

PrintGraphs コマンドを使うと、１枚の用紙に収まらない大きさのグラフのサイズを指定できます。 

このコマンドを実行すると、Igor は複数の用紙を使ってグラフを印刷します。 

これにより、非常に大きなポスターサイズの印刷物を作成できます。 

複数のシートを１枚の大きなポスターにするには、シートの端をトリミングし、テープで貼り合わせる必要がありま

す。 

Igor はページの端に小さな位置合わせマークを印刷するため、ページを揃えることができます。 

不要な余白を切り取り、位置合わせマークが切り取った用紙の端にぴったり合うようにしてください。 

次に、シートを位置合わせマーク同士がぴったり合うように揃えます。 

すべての位置合わせマークがまだ見える状態にしておく必要があります。 

その後、シート同士をテープで貼り合わせます。 

 

その他の印刷方法 

グラフをページレイアウトに配置することで印刷することもできます。 

詳細はヘルプ Page Layouts を参照してください。 

PrintGraphs コマンドを使うと、マクロから直接グラフを印刷できます。 

 

グラフのコピーを保存 

アクティブなグラフを Igor のパックされたエクスペリメントファイルとして

保存するには、File→Save Graph Copy を選択します。 

パックされたエクスペリメントとして保存する主な用途は、データのアーカイ

ブ用コピーを保存すること、または複数のエクスペリメントからのデータを統

合する準備を整えることです（ヘルプ Merging Experiments を参照）。 

結果として生成されるエクスペリメントファイルは、グラフに表示されるウェ

ーブデータのデータフォルダー階層を「最上位」のデータフォルダーから保持

します。 

この最上位データフォルダーとは、グラフに表示される全てのウェーブデータ

を含むデータフォルダーを指します。 
 

パックされたエクスペリメントファイルには、グラフ、そのウェーブ、破線の設定、およびグラフ内で使われた画像

のみが保存され、プロシージャ、変数、文字列、またはエクスペリメント内のその他のオブジェクトは保存されませ

ん。 

Save Graph Copy は、コントロールを含むグラフでは正常に動作しません。 

まず、コントロールはウェーブ、変数、または FIFO（チャートコントロールの場合）に依存している可能性があ

り、これらはグラフのコピー保存では保存されません。 

第２に、コントロールは通常、グラフコピーの保存では保存されないプロシージャに依存しています。 

Save Graph Copy は依存関係について認識しません。 

グラフに wave0 が含まれており、その wave0 がグラフ内に存在しない別の wave1 に依存している場合、グラ
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フのコピーを保存すると wave0 は保存されますが、wave1 は保存されません。 

保存されたエクスペリメントを開くと、依存関係が破損しています。 

SaveGraphCopy コマンドでは、Save Graph Copy メニューコマンドでは使用できないオプションが提供されま

す。 

 

グラフのエクスポート 

グラフをクリップボード経由で、またはファイルを作成して別のアプリケーションにエクスポートできます。 

クリップボード経由で書き出すには、Edit→Export Graphics を選択します。 

ファイル経由で書き出すには、File→Save Graphics を選択します。 

グラフからグラフィックをエクスポートするプロセスは、レイアウトからグラ

フィックをエクスポートするプロセスと非常に似ています。 

このため、詳細についてはヘルプ Exporting Graphics（Windows）に記載し

ています。 

そのセクションでは、使用可能な各種エクスポート方法と、最適な結果を得る

方法の選択方法について説明しています。 
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